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Chapter 1. Installing and removing the toolkit

IBM® Business Monitor development toolkit provides wizards, libraries, and a test
environment to help you create and test monitor models. Business Monitor
development toolkit is installed in an existing Rational® Application Developer or
IBM Integration Designer environment.

Two major components comprise the Business Monitor development toolkit:
v Development environment
v Test environment

The development environment provides the Monitor Model editor and the
debugger. Using the Monitor Model editor, you can create monitor models from
scratch or import preliminary monitor models from WebSphere® Business Modeler.
If you are using the development toolkit in IBM Integration Designer, you can
generate a monitor model from a Process Server or WebSphere Enterprise Service
Bus application. You can use the Monitor Model editor to extend and refine the
monitor model that was generated or imported. You can use the debugger to
troubleshoot problems you find while testing your monitor model or to understand
how your monitor model gathers information.

The test environment includes a complete Business Monitor server, including
Business Space.

With the test environment, you can deploy your monitor model to a server and
view the data in the Business Space. The test environment also supports the
following tasks:
v Promotes fast and iterative development (using the Republish support)
v Allows you to create test events and emit them

Important:

v You must use the same version of the development toolkit as the server that you
plan to use to deploy the monitor model. For example, if you use Business
Monitor development toolkit 8.0 to create your monitor model, you must use
Business Monitor server 8.0 to deploy the model in a production environment.

This installing and removing information is about installing the Business Monitor
development toolkit on Rational Application Developer. To install the toolkit on
IBM Integration Designer, select the Monitor Model editor feature on the IBM
Integration Designer Features page.

Tip: For optimal display of SVG diagrams, install web development tools when
you install IBM Integration Designer or Rational Application Developer.

Before you continue the installation into Rational Application Developer, you must
have the Business Monitor development toolkit DVD or downloadable image
available. If you are using the downloadable image, you must extract the files to a
temporary directory.
Related information:

IBM Installation Manager information center
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Planning to install
Business Monitor development toolkit requires Rational Application Developer
8.0.4 and runs on the Windows operating system.

For the most current software and hardware requirements, refer to the System
requirements for IBM Business Process Manager.

Important: If you did not install a local IBM Business Monitor server, you must
install the Rational Application Developer feature Tools for developing
applications without a local server installation.

Nonadministrative user considerations

If you are installing Business Monitor development toolkit as a nonadministrative
or nonroot user, you must install DB2 before you begin the Business Monitor
development toolkit installation.

To install as a nonadministrative user, you have the following choices:
v Before installing Business Monitor development toolkit, install a DB2 server

separately. For information about installing DB2 as a nonadministrative or
nonroot user, see Required user accounts for installation of DB2 server products
(Windows).

v Logon as an administrator and use the Business Monitor development toolkit
installer to install the DB2 server alone. Grant special permission to the
nonadministrative user. Then logon as the nonadministrative user and install the
Business Monitor development toolkit using the installed DB2 server.

Test environment

Business Monitor development toolkit installation includes an IBM Business
Monitor test environment. You have the option to use either a local test
environment or a remote one. Developers using systems that are constrained on
resources (CPU, memory, disk space) should consider configuring a remote test
environment and pointing their test server at that remote environment for testing
their processes and monitor models.

When the IBM Business Monitor server is installed locally, Rational Application
Developer finds it and displays it in the Servers view. When the server is installed
remotely, you can target it by creating a new server.
1. In the Servers view, right-click and select New > Server.
2. Select IBM > IBM Business Monitor v8.0.
3. Specify the remote server host name and click Next.
4. Specify the profile name, connection, and security information, and click Finish.

If you experience communication problems with the remote server, such as
problems in publishing to the remote server or obtaining the status of the server,
see Resolving communication problems with remote servers.

Installing the toolkit into Rational Application Developer
You can install the IBM Business Monitor development toolkit into an existing
Rational Application Developer environment. The Business Monitor development
toolkit is available for Windows only.
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This installing and removing information is about installing the Business Monitor
development toolkit on Rational Application Developer. To install the toolkit on
IBM Integration Designer, select the Monitor Model editor feature on the IBM
Integration Designer Features page.

Before you complete the installation on Rational Application Developer, you must
have completed the following tasks:
v Installed Rational Application Developer 8.0.4.1
v Selected the Rational Application Developer feature WebSphere Application

Server, version 8.0 development tools feature as part of that installation.

Note: If you installed Rational Application Developer V8.0.4.1 by using the
electronic images (through Passport Advantage®) or by using the physical media
supplied by IBM, be aware of the following information:
v Business Monitor provides a permanent license that can be obtained from

Passport Advantage.
v You must manually install the permanent license by using the Rational

Application Developer Manage Licenses wizard.

You can install the development toolkit into Rational Application Developer using
one of the following methods:
v Using the Business Monitor development toolkit product launchpad program
v Using an existing IBM Installation Manager
v Using the silent installation method
Related information:

IBM Rational Application Developer Version 8.0.4 Information Center

Installing the toolkit into Rational Application Developer using
the product launchpad program

You can install the Business Monitor development toolkit into an existing Rational
Application Developer environment using the product launchpad program
available from the root directory of the installation image. The launchpad program
provides an interactive installation where you select the appropriate options for
your environment.

Before you complete the installation on Rational Application Developer, you must
have completed the following tasks:
v Installed Rational Application Developer 8.0.4.1
v Selected the Rational Application Developer feature WebSphere Application

Server, version 8.0 development tools feature as part of that installation.

Note: If you installed Rational Application Developer V8.0.4.1 by using the
electronic images (through Passport Advantage) or by using the physical media
supplied by IBM, be aware of the following information:
v Business Monitor provides a permanent license that can be obtained from

Passport Advantage.
v You must manually install the permanent license by using the Rational

Application Developer Manage Licenses wizard.
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Important: If you are installing Business Monitor development toolkit with its test
environment as a nonadministrative or nonroot user, you must install DB2 before
you begin the installation.

To install Business Monitor development toolkit using the product launchpad
program complete the following steps. You can run only one launchpad at a time.
1. Optional: If you are installing from downloadable images, extract all the files.

All files should be extracted to the same location on your hard disk drive.
Overwrite directories if prompted.

2. To start the installation program, run launchpad.exe, or launchpad64.exe for a
64-bit system.

Important: To install or run the Business Monitor development toolkit on
Windows 7, Windows Vista, or Windows Server 2008, you must elevate your
Microsoft Windows user account privileges by right-clicking launchpad.exe and
selecting Run as administrator. This is required for both administrative and
nonadministrative users.

3. If you are in the Administrator group, ensure that Install as administrative
user is selected. Clear this check box only if you are not an administrative user,
or if you want to install to your own user name without giving privileges to
other users.

4. Click Install to begin the installation. IBM Installation Manager starts, or
installs and then starts.

5. Install the product according to the instructions in “Installing with IBM
Installation Manager.”

Related information:

IBM Installation Manager information center

Installing with IBM Installation Manager
You can install the Business Monitor development toolkit into your Rational
Application Developer environment interactively using the Installation Manager.

Before you complete the installation on Rational Application Developer, you must
have completed the following tasks:
v Installed Rational Application Developer 8.0.4.1
v Selected the Rational Application Developer feature WebSphere Application

Server, version 8.0 development tools feature as part of that installation.

Note: If you installed Rational Application Developer V8.0.4.1 by using the
electronic images (through Passport Advantage) or by using the physical media
supplied by IBM, be aware of the following information:
v Business Monitor provides a permanent license that can be obtained from

Passport Advantage.
v You must manually install the permanent license by using the Rational

Application Developer Manage Licenses wizard.

Important: If you are installing Business Monitor development toolkit with its test
environment as a nonadministrative or nonroot user, you must install DB2 before
you begin the installation.
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If you are installing this product using the launchpad, then Installation Manager
has automatically been started and configured for you, so you can skip directly to
Step 2.
1. Optional: If you are NOT installing from the launchpad, complete the following

steps:
a. Click Start > All Programs > IBM Installation Manager > IBM Installation

Manager to start the Installation Manager.

Note: If a newer version of Installation Manager is found, you are
prompted to confirm that you want to install it before you can continue.
Click OK to proceed. Installation Manager automatically installs the new
version, restarts, and resumes.

b. Define the repository location. Click File > Preferences to open the
Installation Manager Preferences page.

c. Click Add Repository to add a new repository location. The repository
locations are image_directory/disk1/IMmontk80/repository.config (for the
Business Monitor development toolkit) and image_directory/WTE_Disk/
repository/repository.config (for the test environment), where
image_directory contains the extracted installation image for the Business
Monitor development toolkit.

d. Click Browse to browse to the repository location. Click OK. The new
repository location is added to the list of repositories.

e. Click OK on the Repositories configuration page to save your preferences
and exit the Preferences page.

f. From the Installation Manager Start page, click Install.
2. Ensure that the Business Monitor development toolkit package is selected and

any updates to the package that you want to install. Updates that have
dependencies are automatically selected and cleared together. The following
packages are selected for you:
v IBM Cognos® Business Intelligence (clear the check box if you are not an

administrative user)
v WebSphere Application Server - ND (clear the check box if the package is

already installed)
v DB2 Express (clear the check box if you already have a DB2 database

installed or if you are not an administrative user)
v IBM Business Monitor
v Business Monitor development toolkit

3. On the Licenses page, read the license agreement for the selected packages.
If you selected more than one package to install, there might be a license
agreement for each package. On the left side of the License page, click each
package version to display its license agreement. The package versions that you
selected to install (for example, the base package and an update) are listed
under the package name.
a. If you agree to the terms of all of the license agreements, click I accept the

terms of the license agreements.
b. Click Next to continue.

4. On the Location page, click the package_group that contains the Rational
Application Developer package. If the selected package group does not meet
the required prerequisites for the toolkit, you will receive an error.
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a. If you are creating a test environment, you might want to change the
default path for the test environment. Select WebSphere Application Server
- ND and enter the path for the test environment.

b. Click Next to continue.
5. On the Features page, select the package features that you want to install. If

you did not select it, then it is not displayed as an installable feature.
a. Optional: To see the dependency relationships between features, select

Show Dependencies.
b. Optional: Click a feature to view its brief description under Details.
c. Select or clear features in the packages. Installation Manager will

automatically enforce any dependencies with other features and display
updated download size and disk space requirements for the installation.
v If you select one or more stand-alone development profiles, the profiles

are created for you during installation. A profile might already be selected
based on the options you chose.
A stand-alone development profile is a default development profile that
provides a IBM Business Monitor test environment. If you choose not to
install a default stand-alone development profile, you can install one later
by launching the Installation Manager and clicking Modify on the first
page.

d. When you are finished selecting features, click Next to continue.
6. On the Profiles page, enter the credentials for the stand-alone profile and the

test server that you are creating. The default user name is admin and the default
password is admin.

7. If you selected DB2 Express, on the Common Configurations page, enter a user
name and password for DB2 and click Next. The default user name is bpmadmin.
Choose a password that complies with the password policy of your system (for
example, Windows 2008).

Restriction: User names must not contain NL strings.
8. On the Summary page, review your choices before installing the IBM Business

Process Manager Advanced: Process Server package. If you want to change the
choices that you made on previous pages, click Back and make your changes.
When you are satisfied with your installation choices, click Install to install the
package. A progress indicator shows the percentage of the installation
completed.

9. When the installation process is complete, a message confirms the success of
the process.
a. Click View log file to open the installation log file for the current session in

a new window. You must close the Installation Log window to continue.
b. Depending on whether you selected to install a test environment, you might

be given the option to create a profile when you exit. If you have already
created a stand-alone profile as part of the installation, select None.

c. Click Finish to close the Installation Manager.
Related information:

IBM Installation Manager information center

Installing the toolkit silently
You can install the Business Monitor development toolkit in silent installation
mode. When you install in silent mode, the user interface is not available.
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Installing the toolkit silently using the command line
You can install the Business Monitor development toolkit using the command line.

Before you complete the installation on Rational Application Developer, you must
have completed the following tasks:
v Installed Rational Application Developer 8.0.4.1
v Selected the Rational Application Developer feature WebSphere Application

Server, version 8.0 development tools feature as part of that installation.

Note: If you installed Rational Application Developer V8.0.4.1 by using the
electronic images (through Passport Advantage) or by using the physical media
supplied by IBM, be aware of the following information:
v Business Monitor provides a permanent license that can be obtained from

Passport Advantage.
v You must manually install the permanent license by using the Rational

Application Developer Manage Licenses wizard.

Important: If you are installing Business Monitor development toolkit with its test
environment as a nonadministrative or nonroot user, you must install DB2 before
you begin the installation.

If you do not have the prerequisite base products necessary for the Business
Monitor development toolkit installation, you must install them as part of the
silent installation. The required base products are:
v Installation Manager
v WebSphere Application Server Network Deployment (if you are installing the

test environment)

The silent installation performs the following tasks:
v Installs Installation Manager if it is not already installed or updates it to the

appropriate level if it is installed.
v Installs the required base products and the toolkit.

To silently install Business Monitor development toolkit, complete the following
steps:
1. Run the following command to generate encrypted passwords using IBM

Installation Manager to securely connect to DB2 and the WebSphere
administrative console.

Important: If you are running Windows 7, Windows Vista, or Windows Server
2008, start your command prompt by right-clicking and selecting Run as
administrator.
IM_location\eclipse\tools\imutilsc -silent -nosplash encryptString password_to_encrypt

IM_location/eclipse/tools/imutilsc -silent -nosplash encryptString password_to_encrypt

2. Read and accept the license terms before installing. Adding -acceptLicense to
the command line means that you accept all licenses.

3. Run the following command:

Important: If you are running Windows 7, Windows Vista, or Windows Server
2008, start your command prompt by right-clicking and selecting Run as
administrator.
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extract_directory\disk1\IM_win32\tools\imcl install list_of_product_IDs
-acceptLicense -installationDirectory location -repositories repository
-showVerboseProgress -log logName.log

where:
v list_of_product_IDs is a list of the IDs for the products you want to install,

separated by spaces.

Table 1. Product IDs

Product Product ID

Business Monitor development toolkit com.ibm.wbimonitor.toolkit.v80

Installation Manager com.ibm.cic.agent,agent_core,agent_jre

v location is the path to the directory where you want to install the products.
v repository is the path to the repository where you have extracted the files, one

or more of the following directories:
extract_directory/disk1/IMmontk80
extract_directory/disk1/IM_win32

For more than one repository, separate the repository locations with commas.
v logName is the name of the log file to record messages and results.

Running this command installs the product with the default features. If you
want to install specific features or make other changes, see the reference link
for the command-line arguments for imcl.

4. If you also want to install the test environment, run the same command again
with a different installation directory and the required product IDs and keys:
extract_directory\disk1\IM_win32\tools\imcl install list_of_product_IDs
-acceptLicense -testInstallationDirectory location -repositories repository
-properties key=value,key=value -showVerboseProgress -log logName.log

where:
v list_of_product_IDs is a list of the IDs for the products you want to install,

separated by spaces.
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Table 2. Product IDs for test environment

Product Product ID

IBM Business Monitor com.ibm.websphere.MON.V80 (use for
default features)

or

com.ibm.websphere.MON.V80,
wbm.core.feature,wbm.profile.feature
(use to install IBM Business Monitor with an
IBM Business Monitor profile)

or

com.ibm.websphere.MON.V80,
wbm.core.feature,wbm.wps.profile
(use to install IBM Business Monitor with an
IBM Business Monitor and IBM BPM
Process Server profile)

or

com.ibm.websphere.MON.V80,
wbm.core.feature,wbm.wesb.profile.feature
(use to install IBM Business Monitor with an
IBM Business Monitor and IBM WebSphere
Enterprise Service Bus profile)

WebSphere Application Server Network
Deployment (32-bit)

com.ibm.websphere.ND.v80,core.feature,
ejbdeploy,thinclient,embeddablecontainer,
samples,com.ibm.sdk.6_32bit
(includes all required features)

WebSphere Application Server Network
Deployment (64-bit)

com.ibm.websphere.ND.v80,core.feature,
ejbdeploy,thinclient,embeddablecontainer,
samples,com.ibm.sdk.6_64bit
(includes all required features)

DB2 for Windows 32-bit com.ibm.ws.DB2EXP97.winia32

DB2 for Windows 64-bit com.ibm.ws.DB2EXP97.winia64

IBM Cognos BI for Windows x86 (32-bit) com.ibm.ws.cognos.v1011.winia32

IBM Cognos BI for Windows x64 (64-bit) com.ibm.ws.cognos.v1011.winia64

v location is the path to the directory where you want to install the products.
v repository is the path to the repository where you have extracted the files, one

of the following directories:
extract_directory/repository/repos_32bit
extract_directory/repository/repos_64bit

For more than one repository, separate the repository locations with commas.
v key=value is a list of the keys and values you want to pass to the installation,

separated by commas. Do not put spaces between the commas. Create
encrypted passwords using the IBM Installation Manager.
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Table 3. Keys for test environment

Key Description

user.select.64bit.image If you are installing on a 64-bit operating
system, add the following line exactly:

user.select.64bit.image,,
com.ibm.websphere.ND.v80=true

The default value is false.

user.db2.admin.username User name with authority to access the DB2
database. The default value is bpmadmin.

user.db2.admin.password Password for the user name. Choose a
password that complies with the password
policy of your system (for example,
Windows 2008).

user.bpm.admin.username User name for the administrative console.
The default value is admin. This property is
needed only if you are creating a profile.

user.bpm.admin.password Password for the user name. The default
value is admin. This property is needed only
if you are creating a profile.

user.db2.port Port for the DB2 database. The default value
is 50000.

v logName is the name of the log file to record messages and results.

Running this command installs the test environment with the default features.
If you want to install specific features or make other changes, see the reference
link for the command-line arguments for imcl.

Installation Manager installs the list of products and writes a log file to the
directory that you specified.

The following example installs the Business Monitor development toolkit on
Windows.
imcl install com.ibm.monitor.toolkit.v80 -acceptLicense -installationDirectory
C:\IBM\TKIT -repositories D:\temp\montk\disk1\IMmontk80 -showVerboseProgress
-log silentinstall.log

Related reference:

Command-line arguments for imcl
Related information:

IBM Installation Manager information center

Installing the toolkit silently using a response file
You can install Business Monitor development toolkit by creating a response file
and then running a command to use that response file to install the toolkit.

Before you complete the installation on Rational Application Developer, you must
have completed the following tasks:
v Installed Rational Application Developer 8.0.4.1
v Selected the Rational Application Developer feature WebSphere Application

Server, version 8.0 development tools feature as part of that installation.
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Note: If you installed Rational Application Developer V8.0.4.1 by using the
electronic images (through Passport Advantage) or by using the physical media
supplied by IBM, be aware of the following information:
v Business Monitor provides a permanent license that can be obtained from

Passport Advantage.
v You must manually install the permanent license by using the Rational

Application Developer Manage Licenses wizard.

Important: If you are installing Business Monitor development toolkit with its test
environment as a nonadministrative or nonroot user, you must install DB2 before
you begin the installation.

To silently install Business Monitor development toolkit, complete the following
steps:
1. Read and accept the license terms before installing. Adding -acceptLicense to

the command line means that you accept all licenses.
2. Create the response file that will install Business Monitor development toolkit.

Copy the sample response file in the following directory to create your own
response file:
extract_directory/disk1/responsefiles/responsefile.install.xml

3. The default values provided in the sample response files will perform a basic
install, but you should review the file and its comments, and modify the
parameters as needed for your environment.

Important: Verify that the repository locations in your response file point to the
correct location in your environment and that other parameter values are also
appropriate.

4. Run the following command:

Important: To install or run the Business Monitor development toolkit on
Windows 7, Windows Vista, or Windows Server 2008, you must elevate your
Microsoft Windows user account privileges by right-clicking launchpad.exe and
selecting Run as administrator. This is required for both administrative and
nonadministrative users.
To install as administrator:
extract_directory\IM\installc.exe -acceptLicense input extract_directory
\disk1\responsefiles\responsefile.install.xml -log preferred_log_location
\silent_install.log

To install as nonadministrator:
extract_directory\IM\userinstc.exe -acceptLicense input extract_directory
\disk1\responsefiles\responsefile.install.xml -log preferred_log_location
\silent_install.log

Installation Manager installs any required prerequisites and Business Monitor
development toolkit and writes a log file to the directory you specified.
Related tasks:

Installing silently with Installation Manager

Recording a response file with Installation Manager
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Updating the development toolkit
You can update the IBM Business Monitor development toolkit in the Rational
Application Developer environment.
Related information:

IBM Installation Manager information center

Installing fix packs interactively
You can install fix packs for the IBM Business Monitor development toolkit
interactively.

By default, Internet access is required unless your repository preferences points to
your local update site.

Each installed package has the location embedded for its default IBM update
repository. For Installation Manager to search the IBM update repository locations
for the installed packages, the preference Search service repositories during
installation and updates on the Repositories preference page must be selected.
This preference is selected by default.

During the update process, Installation Manager might prompt you for the location
of the repository for the base version of the package. If you installed the product
from DVDs or other media, they must be available when you use the update
feature.

See the Installation Manager information center for more information.

Important: If you created profiles in an earlier version, those profiles are preserved
and you do not need to create them again.

You cannot use this procedure to install updates on the underlying IBM DB2
Express or IBM Cognos BI. You must update these products following their normal
update processes.

To find and install product package updates:
1. Close all programs that were installed using Installation Manager before

updating.
2. Start Installation Manager. From the Start page of the Installation Manager,

click Update.
3. If IBM Installation Manager is not detected on your system or if an older

version is already installed, then you must continue with the installation of
the latest release. Follow the on-screen instructions in the wizard to complete
the installation of IBM Installation Manager.

4. In the Update Packages wizard, select the package group containing the
product package you want to update or select the Update all check box, and
then click Next. Installation Manager searches for updates in its repositories
and the predefined update sites for the software you are updating. A progress
indicator shows the search is taking place.

5. If updates for a package are found, then they are displayed in the Updates list
on the Update Packages page below their corresponding package. Only the
latest recommended updates are displayed by default. Click Show all to
display all updates found for the available packages.
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a. To learn more about an update, click the update and review its description
under Details.

b. If additional information about the update is available, a More info link is
included at the end of the description text. Click the link to display the
information in a browser. Review this information before installing the
update.

6. Select the updates that you want to install or click Select Recommended to
restore the default selections, and click Next. Updates that have a dependency
relationship are automatically selected and cleared together.

7. On the Licenses page, read the license agreements for the selected updates. On
the left side of the Licenses page, the list of licenses for the updates you
selected is displayed; click each item to display the license agreement text. If
you agree to the terms of all the license agreements, click I accept the terms
of the license agreements. Then click Next.

8. On the Summary page, review your choices before installing the updates.
a. If you want to change the choices you made on previous pages, click Back,

and make your changes.
b. When you are satisfied, click Update to download and install the updates.

A progress indicator shows the percentage of the installation completed.
9. Optional: When the update process completes, a message that confirms the

success of the process is displayed near the top of the page. Click View log
file to open the log file for the current session in a new window. You must
close the Installation Log window to continue.

10. Click Finish to close the wizard.
11. Close Installation Manager.
Related information:

IBM Installation Manager information center

Rolling back fix packs
Using the Roll Back Packages wizard, you can remove a fix pack from the IBM
Business Monitor development toolkit and revert to a previous version.

During the rollback process, Installation Manager must access files from the earlier
version of the package. By default, these files are stored on your system when you
install a package. If the files are not available on your workstation, you must
include the location of the repository from which you installed the previous
version of the product in your Installation Manager preferences (File > Preferences
> Repository). If you installed the product from DVD or other media, they must
be available when you use the rollback feature.

Use the rollback feature if you have applied an update to a product package, and
decide later that you want to remove the update and revert to the earlier version
of the product. When you use the rollback feature, the Installation Manager
uninstalls the updated resources, and reinstalls the resources from the previous
version.

Note: A rollback process to a stand-alone server can disable the WebSphere test
environment. You must reset the test environment profile after you complete the
rollback process. To reset a test environment profile, see Creating or resetting
default server profiles.
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See the help in the Installation Manager for more information on using the
Rollback wizard.

To roll back an updated package, complete the following steps:
1. On the Start page of the Installation Manager, click Roll Back to start the

Rollback wizard.
2. From the Roll Back Packages list, select the package that you want to roll back.
3. Complete the wizard according to the on-screen instructions.
Related information:

IBM Installation Manager information center

Installing fix packs silently
You can install fix packs for the Business Monitor development toolkit using the
command line.

You cannot use this procedure to install updates on the underlying IBM DB2
Express or IBM Cognos BI. You must update these products following their normal
update processes.

To update the toolkit silently, complete the following steps:
1. Read and accept the license terms before updating. Adding -acceptLicense to

the command line means that you accept all licenses.
2. Run the following command:

Important: If you are running Windows 7, Windows Vista, or Windows Server
2008, start your command prompt by right-clicking and selecting Run as
administrator.
extract_directory\disk1\IM_win32\tools\imcl install com.ibm.wbimonitor.toolkit.v80
-acceptLicense -installationDirectory location -repositories repository
-showVerboseProgress -log logName.log

where:
v location is the path to the directory where you want to update the product.
v repository is the path to the repository where you have extracted the fix pack

files. For more than one repository, separate the repository locations with
commas.

v logName is the name of the log file to record messages and results.
3. If you also want to update the test environment, run the same command

again with the correct installation directory and the required product IDs and
keys:
extract_directory\disk1\IM_win32\tools\imcl install list_of_product_IDs
-acceptLicense -testInstallationDirectory location -repositories repository
-showVerboseProgress -log logName.log

where:
v list_of_product_IDs is a list of the IDs for the products you want to update,

separated by spaces.

Table 4. Product IDs for test environment

Product Product ID

IBM Business Monitor com.ibm.websphere.MON.V80
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Table 4. Product IDs for test environment (continued)

Product Product ID

WebSphere Application Server Network
Deployment

com.ibm.websphere.ND.v80

v location is the path to the directory where you want to update the products.
v repository is the path to the repository where you have extracted the fix pack

files. For more than one repository, separate the repository locations with
commas.

v logName is the name of the log file to record messages and results.

Installation Manager updates the products and writes a log file to the directory
that you specified.

The following example updates the Business Monitor development toolkit.
imcl install com.ibm.wbimonitor.toolkit.v80 -acceptLicense -installationDirectory
C:\IBM\TKIT -repositories D:\temp\montk\fixpack1 -showVerboseProgress -log update.log

Related reference:

Command-line arguments for imcl
Related information:

IBM Installation Manager information center

Uninstalling the development toolkit
You can use IBM Installation Manager to remove the Business Monitor
development toolkit from your computer. IBM Installation Manager supports both
interactive and silent methods.

Before you uninstall the development toolkit, you must have completed the
following tasks:
v Uninstall the FDL to monitor model utility for WebSphere MQ Workflow from

Rational Application Developer

For instructions on how to uninstall this plug-in, refer to “Removing the FDL to
monitor model utility for WebSphere MQ Workflow” on page 18.
Related tasks:
“Removing the FDL to monitor model utility for WebSphere MQ Workflow” on
page 18
If you need to remove the Business Monitor development toolkit, you will have to
remove the FDL to monitor model utility from Integration Designer or Rational
Application Developer first. Otherwise you will see several warning messages.

Uninstalling the toolkit interactively
Use the IBM Installation Manager interactive method to remove the Business
Monitor development toolkit from your computer. The interactive method provides
an interface where you can select the packages to be removed.

To remove the toolkit using the IBM Installation Manager interactive method,
complete the following steps:
1. Close the programs that you installed using Installation Manager.
2. Stop all running servers.
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3. Start the Installation Manager. On the Start page, click Uninstall.
4. On the Uninstall Packages page, select IBM Business Process Manager

Advanced: Process Server and associated packages and click Next.
5. On the Summary page, review the list of packages that will be uninstalled and

then click Uninstall. After the uninstallation finishes, the Complete page opens.
6. Click Finish to exit the wizard.

Uninstalling the toolkit silently
You can uninstall the Business Monitor development toolkit in silent installation
mode. When you uninstall in silent mode, the user interface is not available.

Uninstalling the toolkit silently using the command line
You can use the command-line mode of the Installation Manager to uninstall the
Business Monitor development toolkit.

Close all programs that you installed using the Installation Manager.

To uninstall, you must log in to the system using the same user account that you
used to install.

To uninstall the toolkit using the command line, complete the following steps:
1. Open a command prompt, and change directories to the /eclipse/tools

directory under Installation Manager.

Important: If you are running Windows 7, Windows Vista, or Windows Server
2008, start your command prompt by right-clicking and selecting Run as
administrator.

2. Make the appropriate replacements and run the following command:
imcl uninstall list_of_product_IDs -installationDirectory installationDirectory
-log logLocation

a. Replace list_of_product_IDs with a list of the IDs for the products you
want to uninstall, separated by spaces.

Table 5. Product IDs

Product Product ID

Business Monitor development toolkit com.ibm.wbimonitor.toolkit.v80

Installation Manager com.ibm.cic.agent

b. Replace installationDirectory with the location where you installed the
product.

c. Replace logLocation with the location and file name to log the information.
3. If you also want to uninstall the test environment, make the appropriate

replacements and run the same command again:
imcl uninstall list_of_product_IDs -installationDirectory testInstallationDirectory
-log logLocation

a. Replace list_of_product_IDs with a list of the IDs for the products you
want to uninstall, separated by spaces.

Important: The DB2 Express installation might be used by multiple
products, including products on a remote system. If you uninstall DB2
Express, all DB2 Express databases and database assets are deleted.
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Table 6. Product IDs for test environment

Product Product ID

IBM Business Monitor com.ibm.websphere.MON.V80

WebSphere Application Server Network
Deployment

com.ibm.websphere.ND.v80

DB2 for Windows 32-bit com.ibm.ws.DB2EXP97.winia32

DB2 for Windows 64-bit com.ibm.ws.DB2EXP97.winia64

IBM Cognos BI for Windows x86 (32-bit) com.ibm.ws.cognos.v1011.winia32

IBM Cognos BI for Windows x64 (64-bit) com.ibm.ws.cognos.v1011.winia64

b. Replace installationDirectory with the location where you installed the
product.

c. Replace logLocation with the location and file name to log the information.

The following example uninstalls the Business Monitor development toolkit from
Windows.
C:\Program Files\IBM\Installation Manager\eclipse\tools>imcl uninstall
com.ibm.wbimonitor.toolkit.v80 -installationDirectory C:\IBM\TKIT80
-log uninstalllog.txt

Installation Manager uninstalls the list of products and writes a log file to the
directory that you specified.
Related reference:

Command-line arguments for imcl
Related information:

IBM Installation Manager information center

Uninstalling the toolkit silently using a response file
You can uninstall the Business Monitor development toolkit by creating a response
file and then running a command to use that response file to uninstall the toolkit.

To uninstall the toolkit using a response file, complete the following steps:
1. Go to the toolkit installation image directory.
2. Make a copy of the responsefile.uninstall.xml file.

A sample response file to uninstall the product is also included in the extracted
installation image as:
v extract_directory\disk1\responsefiles\responsefile.uninstall.xml

and on the product DVDs as:
v DVD_root\disk1\responsefiles\responsefile.uninstall.xml

3. Modify the parameters as directed in the text of the response file templates to
create your response files. You can also create response files by recording your
actions in Installation Manager. When you record a response file, the selections
that you make in Installation Manager are stored in an XML file. When you run
Installation Manager in silent mode, Installation Manager uses the data in the
XML response file to perform the installation.

4. Save and close the file.
5. From a command prompt, change to the IBM Installation Manager installation

directory. For example, enter
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cd C:\Program Files\IBM\InstallationManager\eclipse\tools

6. Submit the following command:
imcl.exe input dvd_root\disk1\responsefiles\
responsefile.uninstall.xml -log preferred_log_location\
silent_install.log

Installation Manager uninstalls the Business Monitor development toolkit and
writes a log file to the directory that you specified.
Related information:

IBM Installation Manager information center

Removing the FDL to monitor model utility for WebSphere MQ
Workflow

If you need to remove the Business Monitor development toolkit, you will have to
remove the FDL to monitor model utility from Integration Designer or Rational
Application Developer first. Otherwise you will see several warning messages.

To remove the utility from Integration Designer or Rational Application Developer,
complete the following steps:
1. Click Help > Software Updates > Manage Configuration.
2. Expand the tree to locate the FDL to monitor model utility feature 1.0.9 and

select it.
3. Right-click FDL to monitor model utility feature 1.0.9. The menu displays

Replace with, Disable, Uninstall, and Properties.
4. Click Uninstall.
Related concepts:
“Uninstalling the development toolkit” on page 15
You can use IBM Installation Manager to remove the Business Monitor
development toolkit from your computer. IBM Installation Manager supports both
interactive and silent methods.

Troubleshooting the toolkit installation
There are a few problems you might encounter when installing or removing the
Business Monitor development toolkit.

You can find the latest troubleshooting tips in the Technotes section of the Business
Monitor Support page.
Related information:

WebSphere Business Monitor TechNotes

Server does not appear in the Servers view
After you have installed the IBM Business Monitor development toolkit, the IBM
Business Process Manager server should appear in the Servers view in Rational
Application Developer or Integration Designer. Verify the profile was created and
restart Rational Application Developer or Integration Designer using the -clean
parameter.
1. Verify that the profile was created in the profile_root directory.
2. Start Rational Application Developer or Integration Designer with the -clean

parameter.

18 IBM Business Monitor development toolkit: Installation Guide

http://publib.boulder.ibm.com/infocenter/install/v1r5/index.jsp
http://www.ibm.com/support/search.wss?rs=802&tc=SSSRR3&q=6.1


a. Open a command prompt and navigate to the directory where Rational
Application Developer or Integration Designer is installed.

b. Type one of the following commands depending on your development
environment:

Rational Application Developer: eclipse.exe -clean

Integration Designer: wid.exe -clean

3. If the server still does not appear, create a new server following the instructions
in Adding a new server to the test environment.

Manually removing workspace server configuration
To avoid problems with unresolved project resources, you should not continue to
use the Business Monitor development toolkit workspace after the toolkit has been
uninstalled. However, if you need to use the workspace for non-toolkit projects,
you should first remove any remaining toolkit server configurations.

When you remove Business Monitor development toolkit using IBM Installation
Manager, IBM Business Process Manager server configurations remain in the
workspace. After the uninstallation completes successfully, you can use the
following procedure to delete the configurations from the workspace.
1. In your development application, select Window > Show View > Servers.
2. In the Servers view, delete the server configurations that are applicable to your

environment.
3. When the Delete Server confirmation message is displayed, make selections

pertaining to the deletion of actively running servers and click OK.
Related information:

WebSphere Business Monitor TechNotes

Reinstallation cannot create new profile when using the
Typical installation and configuration option

If you try to reinstall the product to the same location using the Typical installation
and configuration option, or if you try to reinstall after a failed uninstall, the
installation might fail because a new profile cannot be created.

If databases were created for the test environment, the databases must be dropped
before you can create a new profile.

If the databases are not automatically dropped during uninstall, you must drop
them manually.
v For the qbpmaps profile, the default databases are QBPMDB, QPDWDB, and

QCMNDB
v For the qesb profile, the default databases are ECMNDB and QECMNDB (one or

both)
v For the qmwas profile, the default databases are MONITOR and COGNOSCS
v For the qmbpmaps profile, the default databases are QBPMDB, QPDWDB,

QCMNDB, MONITOR, and COGNOSCS
v For the qmesb profile, the default databases are ECMNDB, QECMNDB,

MONITOR, and COGNOSCS
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Importing monitor models from a project interchange file
If you have a project interchange (PI) .zip file containing your monitor models
from a previous release of Business Monitor development toolkit, you can import
the monitor models into a workspace in Rational Application Developer or
Integration Designer.

To import a PI file into a workspace in Rational Application Developer or
Integration Designer, complete the following steps:
1. In Rational Application Developer or Integration Designer, click File > Import.
2. Expand General, click Existing Projects into Workspace, and click Next.
3. On the Import Projects panel, click Select archive file and click Browse. Go to

the PI .zip file and click Open. You can see your projects in the Projects box.
4. Ensure that any project that you want to import has a check mark beside it.
5. Click Finish.

Exporting monitor models to an archive file
You can export your monitor models to an archive file from Rational Application
Developer or Integration Designer.

To export an archive file from a Rational Application Developer or Integration
Designer workspace, complete the following steps:
1. In Rational Application Developer or Integration Designer, click File > Export.
2. Expand General, click Archive , and click Next.
3. On the Archive File panel, select the check boxes for the projects to include in

the archive file.
4. In the To archive file field, enter a file name. Ensure that the Save in zip

format and Create directory structure for files options are selected.
5. Click Finish.
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Chapter 2. Directory conventions

This topic defines the default paths and folder names of the IBM Business Process
Manager product and product components.

Because your file paths might vary from the default file paths that are determined
during product installation, the documentation identifies these values as variables.
The variables used throughout the documentation are defined in the following
sections.

Installation image

Installation image refers to the file structure on a product CD or the file structure
created locally as a result of either copying the product CD or uncompressing the
software packages that you downloaded from Passport Advantage or other
distribution area.

monitor_installation_image
Represents the IBM Business Process Manager installation image.

toolkit_installation_image
Represents the Business Monitor development toolkit installation image.

Default installation locations

When you install software and do not specify an installation location, the
installation program uses a default location to install the product in. This location
is called the default installation directory. These paths are defined as variables
throughout the documentation because a user might or might not choose to install
products in the default directory and the default directory structure can vary by
operating system.

monitor_root
The following default installation root directories are for IBM Business
Process Manager when installed from Installation Manager:

AIX®: /usr/IBM/WebSphere/AppServer

Linux: /opt/ibm/WebSphere/AppServer

Solaris: /opt/ibm/WebSphere/AppServer

Windows: C:\Program Files\IBM\WebSphere\AppServer

Tip: For Windows installations, keep the path as short as possible.
Otherwise, you might run into problems later when the paths of other
components, when added to this path, exceed the 255-character path limit.

The following default installation root directories are for IBM Business
Process Manager when installed silently:

AIX: /usr/IBM/WebSphere/MonServer

Linux: /opt/ibm/WebSphere/MonServer

Solaris: /opt/ibm/WebSphere/MonServer

Windows: C:\IBM\WebSphere\MonServer
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app_server_root
The following default installation root directories are for WebSphere
Application Server:

AIX: /usr/IBM/WebSphere/AppServer

Linux: /opt/IBM/WebSphere/AppServer

Solaris: /opt/IBM/WebSphere/AppServer

Windows: C:\Program Files\IBM\WebSphere\AppServer

profile_root
The following default installation root directories are for WebSphere
Application Server profiles when installed from Installation Manager:

AIX: /usr/IBM/WebSphere/AppServer/profiles/profile_name

Linux: /opt/IBM/WebSphere/AppServer/profiles/profile_name

Solaris: /opt/IBM/WebSphere/AppServer/profiles/profile_name

Windows: C:\Program Files\IBM\WebSphere\AppServer\profiles\
profile_name

The following default installation root directories are for WebSphere
Application Server profiles when installed silently:

AIX: /usr/IBM/WebSphere/MonServer/profiles/profile_name

Linux: /opt/IBM/WebSphere/MonServer/profiles/profile_name

Solaris: /opt/IBM/WebSphere/MonServer/profiles/profile_name

Windows: C:\Program Files\WebSphere\MonServer\profiles\
profile_name

portal_root
The following default installation root directories are for WebSphere Portal:

AIX: /usr/IBM/WebSphere/PortalServer

Linux: /opt/IBM/WebSphere/PortalServer

Solaris: /opt/IBM/WebSphere/PortalServer

Windows: C:\Program Files\IBM\WebSphere\PortalServer

integration_dev_root
The following path is the default installation directory for Integration
Designer:

Windows: C:\IBM\IntegrationDesigner\v8.0
Linux: /opt/IBM/IntegrationDesigner/v8.0

app_dev_root
The following path is the default installation directory for Rational
Application Developer:

Windows: C:\Program Files\IBM\SDP

Default installation directories for the Installation Manager

The Installation Manager uses two default directories. One is the directory into
which the product launchpad installs the Installation Manager. The other is the
agent data location directory, which the Installation Manager uses for data
associated with the application, such as the state and history of operations
performed by the Installation Manager. For more information about the agent data
location, see Agent data location in the related link.
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root_installation_directory
The following path is the default installation directory for the Installation
Manager for a root or administrative user:

AIX: /opt/IBM/InstallationManager/eclipse

Linux: /opt/IBM/InstallationManager/eclipse

Solaris: /opt/IBM/InstallationManager/eclipse

Windows: C:\Program Files\IBM\Installation Manager\eclipse

nonroot_installation_directory
The following path is the default installation directory for the Installation
Manager for a nonroot or nonadministrative user:

AIX: user_home/IBM/InstallationManager/eclipse

Linux: user_home/IBM/InstallationManager/eclipse

Solaris: user_home/IBM/InstallationManager/eclipse

Windows: C:\Documents and Settings\userID\IBM\Installation
Manager\eclipse

root_agent_data_directory
The following path is the default agent data location directory for the
Installation Manager for a root or administrative user:

AIX: /var/ibm/InstallationManager

Linux: /var/ibm/InstallationManager

Solaris: /var/ibm/InstallationManager

Windows: C:\Documents and Settings\All Users\Application
Data\IBM\Installation Manager

nonroot_agent_data_directory
The following path is the default agent data location directory for the
Installation Manager for a nonroot or nonadministrative user:

AIX: user_home/var/ibm/InstallationManager

Linux: user_home/var/ibm/InstallationManager

Solaris: user_home/var/ibm/InstallationManager

Windows: C:\Documents and Settings\userID\Application
Data\IBM\Installation Manager
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Notices

U.S. Government Users Restricted Rights - Use, duplication or disclosure restricted
by GSA ADP Schedule Contract with IBM Corp.

This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this
documentation in other countries. Consult your local IBM representative for
information on the products and services currently available in your area. Any
reference to an IBM product, program, or service is not intended to state or imply
that only that IBM product, program, or service may be used. Any functionally
equivalent product, program, or service that does not infringe any IBM intellectual
property right may be used instead. However, it is the user's responsibility to
evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this documentation. The furnishing of this documentation does not
give you any license to these patents. You can send license inquiries, in writing, to:
IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:
IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OR
CONDITIONS OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.
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Licensees of this program who want to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this documentation and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples may include
the names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrates programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM for the purposes of developing, using, marketing, or distributing application
programs conforming to IBM's application programming interfaces.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. 2000, 2011. All rights reserved.
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If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Programming interface information

Programming interface information is intended to help you create application
software using this program.

General-use programming interfaces allow you to write application software that
obtain the services of this program's tools.

However, this information may also contain diagnosis, modification, and tuning
information. Diagnosis, modification and tuning information is provided to help
you debug your application software.

Warning: Do not use this diagnosis, modification, and tuning information as a
programming interface because it is subject to change.

Trademarks and service marks

IBM, IBM Logo, WebSphere, Rational, DB2, Universal Database DB2, Tivoli, Lotus,
Passport Advantage, developerWorks, Redbooks, CICS, z/OS, and IMS are
trademarks or registered trademarks of International Business Machines
Corporation in the United States or other countries or both.

UNIX is a registered trademark of The Open Group in the United States, other
countries, or both.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.

Microsoft and Windows are trademarks or registered trademarks of Microsoft
Corporation in the United States, other countries, or both.

Linux is a trademark of Linus Torvalds in the United States, other countries, or
both.

Adobe is either a registered trademark or trademark of Adobe Systems
Incorporated in the United States, other countries, or both.

Other company, product and service names may be trademarks or service marks of
others.
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